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Pixels and Resolution and Image Size, Oh My!
Resolution and image size have the potential to be among the most confusing topics in Photoshop. How big
should I make it? What resolution should I use for printing? What's the best way to resize my image? This column
will attempt to shed a little light on these questions.

T
he first thing we need to agree on here is to approach
the topic of resolution based on the final output of the
document: onscreen or print; and if print, is it InkJet or

commercial printing? The reason for making these distinctions
is that it's a whole lot simpler to talk about resolution with the
artwork's destination in mind.

For example, you've probably read discussions about the ideal
pixels per inch (ppi) or dots per inch (dpi) to use when printing.
But when we're talking about images being used onscreen (Web,
presentations, video, or slide shows), you can take those factors
right out of the conversation (more on printing, ppi, and dpi later).

Think about pixel dimensions
The simplest way to think about resolution for onscreen use is by
pixel dimensions. For example, if I want my PowerPoint presenta-
tion to look good on my monitor, and my monitor is set to a
resolution of 1024x768 pixels, then that's an ideal size for photos
that I want to be seen full screen. And, if I need an image to fill
only a portion of a slide, then I would create it at a smaller size,
using 1024x768 as my guideline.

Just to prove a point, try this: Imagine that you've been asked
to make a banner with the dimensions of 800x200 pixels for a
webpage. Go up to the File menu and choose New. In the New
dialog, enter a Width of 800 pixels, a Height of 200 pixels, and
a Resolution of 72 pixels/inch. The bottom-right corner of the
New dialog indicates that this will create a file size of 468.8K.
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Now, change the Resolution to 300 and notice that the file
size doesn't change.
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Both files would look the same in Photoshop and would
display at the same size on a webpage. If you checked the size
of each document through the Image Size dialog (lmage>lmage
Size), the difference would be in the Document Size section,
which can be thought of as the printing size; however, we're not
printing this graphic so the resolution is irrelevant.

Therefore, if you know that you're preparing a graphic for
onscreen use, think pixel size and everything will be simpler.
It's interesting to note that many commercial labs that print
photographs are starting to talk pixel dimensions too: It's much
simpler to tell a customer to submit a file that's 2000x2500 pix-
els when printing an 8x10" print. Images come from our camera
expressed in pixel dimensions, so why not continue to speak the
same language when preparing to send images to a lab?

Here's what I mean: If you open a file shot in RAW format
with a 10-megapixel camera, when you open it in Adobe Cam-
era Raw, the image size is expressed in terms of pixel dimen-
sion—2592x3872. Once again, the resolution setting (this time
in the Camera Raw Workflow Options dialog) is only relevant
to the resolution you'd
use for printing. Note:
Click on the blue hyperlink

1024 by 1530 (1,6 MP) -
1371 by 2048 (2,8 MP) -
2056 by 3072 (6.3 MP) -

to the right of Save Image
at the bottom of the Cam-
era Raw window to open
this dialog.

•f 2592 by 3872 (10.0 MP)
2742 by 4096 (11.2 MP)
3427 by 5120 (17.S MP)
4113 by 6144 (25.3 MP)
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Say you plan to send this image to your favorite lab, then check

their website to see how large you can print it without losing qual-

ity. As long as your native pixel dimensions are equal to or larger

than their minimum requirements, you're good to go.

Last stop: printing

In the world of printing, we need to distinguish between print-

ing on our own InkJet or laser printers and printing at a com-

mercial printer (brochures, magazines, etc.) or photo lab. As we

discussed earlier, check with the photo lab to find out what size

requirements they have and send in your photo at an appropri-

ate size. Commercial printers will talk resolution—typically,

266-300 ppi for high-quality printing at the final size. In other

words, if you plan to print an 8x10" photo in a brochure, it should

be 8x10" at 300 ppi.

InkJet printers can be even more confusing, as they're described

as a 1440-dpi (or some other dpi) printer. "Dots per inch" (dpi)

is a term that indicates the quality that the printer is capable of

printing, but it's not an indicator of the ppi we should use. Many

people find that a resolution of 240 ppi is more than enough for

a great quality print on most InkJet printers. How do you know

for sure? Although it will take a little paper and ink, I'd suggest

running a test: Take a 5x7" photo and print it on your InkJet at

300 ppi. Then use the Image Size dialog (lmage>lmage Size) to

lower the resolution to 240 ppi, and print that. (See "Resampling

in image Size" for more information on resizing an image.) Now,

use the Image Size dialog to lower the resolution to 200 ppi, and

print that one. Try printing a series of photos at resolutions as

low as 120 ppi and see if there's any noticeable difference—

chances are, there won't be a huge difference.

All this suggests is that although 240 ppi is the ideal resolu-

tion to use, if you have a photo that doesn't contain enough pixel

information to print at 240 ppi, in a pinch you might be able to

get away with a lower resolution.

One final piece of advice: It's easier to decrease the resolution

rather than increase it—and there will be less chance of quality

loss. So if you're not sure how "big" to capture a file or how

large a setting to use in Camera Raw, err on the side of "too big,"

because you can always make it smaller without losing quality.

RESAMPLING IN IMAGE SIZE

One of the biggest sources of confusion in the Image Size

dialog is the Resample Image checkbox. Here's the way to
decide whether to check or uncheck that box:

• If you want to lower the resolution (ppi) of a file without

changing its width and height, check the Resample Image

box. This will also result in a smaller document size, as

indicated at the top of the dialog. This is what you use to

decrease the resolution for printing on your inkjet.
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If you want to lower the resolution and change the width

and height, uncheck Resampie Image. This means that if

you lower the resolution, the width and height will increase

in size. This is a very useful way to check how large you can

print a document: Set the resolution to 240 ppi for your

inkjet and you'll see the maximum width and height you

can print. •
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If you have an idea for a "Beginners' Workshop" topic, please

send it to letters@photoshopuser.com; however, if you have

a question that you'd like answered immediately, go to the

Help Desk at www.photoshopuser.com.



The (Pixel) Size is the Thing
One of the most potentially confusing concepts in Photoshop is changing the size of a document—especially
when using the Image Size dialog. Resize Pixel Dimensions or Document Size? Resolution? Resample Image or
not? If so, how? Bicubic? Bilinear? In this article, we'll attempt to demystify this dialog's inner workings.

F
irst, let's clear up some puzzling terminology, resiz-

ing vs. resampling. When you resize a document in

Photoshop, you're not making it physically bigger or

smaller—that's what resampling does.

In Photoshop, resizing means taking the existing pixels

and playing with the numbers to change the quality of the

image—the dimensions stay the same. To scale an image and

make it smaller or bigger, we resample the image: Change the

number of pixels in a document and therefore its dimensions.

More on this as we go through the options in the Image

Size dialog.

When you first open an image and look at the Image Size

dialog (lmage>lmage Size or press Command-Option-l [PC:

Ctrl-Alt-l]), you're presented with a couple of different ways of

looking at the size. As we'll see, the method you use depends

on what you're doing with your document.
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Understanding Pixel Dimensions
In the Image Size dialog the Width and Height are shown in

pixels by default. If you're working with a photo captured by

your camera or from Adobe Camera Raw, the dimensions are

established by the camera's quality setting or by the settings

you choose in the Workflow Options dialog in Camera Raw

(accessed by clicking the blue hyperlink under the image).

Workflow Options

Space: ! Adobe RGB (1998)

Depth: | 8 Bits/Channel

Size: ' 4288 by 2848 itt.2 MP)

Resolution: 240 ; pixels/inch

Sharpen For: ! None Amouiit. '

Open in Photoshop as Smart Objects

Note that the document (file) size is also shown in the Image

Size dialog—in our example 34.9 MB—which can often be a

useful indicator of image size, as we'll see later.

By default, the Width and Height are linked together (because

the Constrain Proportions box is checked on) so that if you

change one measurement, the other changes proportionally.

Typically, this setting is left on—unless you're going for the

squished or stretched look.

In general, we use Pixel Dimensions to choose the size of
a document when preparing images for the Web, for video,

and even when sending to a commercial lab for printing. For

example, at www.Mpix.com, they recommend the ideal file
size for printing as follows: a 16x20" should have dimensions

of 4000x5000 pixels, with the minimum dimensions being

2000x3000 pixels. Nowhere is resolution discussed. In effect

what Mpix is saying is that as long as you give them "this many"

pixels for "this many" inches, then your print will look great.

In practice, if you want to change the document width from

4288 pixels to 800 pixels, you enter 800 in the Width field and

the document is resampled to that new pixel width.
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Working with Document Size
In the Document Size section of the Image Size dialog, we see
Width, Height, and Resolution, with inches as the default unit
of measure (set in Photoshop [PC: Edit]> Preferences>Units &
Rulers). Generally, this is useful when you're printing to your
own printer and you know the resolution that works well for
your device, or you're preparing a file to be placed into page-
layout software to be printed at a specific size and resolution.
Here's an example:

In Image Size, our photo is 21.44x14.24 inches at a Resolu-
tion of 200 pixels/inch (the Resolution is based on the choice
made above in the Camera Raw Workflow Options). Because I
use 240 pixels/inch for printing to my inkjet printer, I'll change
the Resolution to match and uncheckthe Resample Image box.
Notice how the chain now links all three values—Width, Height,
and Resolution—and the Pixel Dimensions section at the top
can no longer be edited. What this means is that I'm keeping
the pixel size of 4288x2488 and just "re-distributing" (resizing)
the pixels to fit a new resolution. When I enter a value of 240
into the Resolution field, Image Size does the math, letting me
know that 1 can print a page as large as 17.867x11.867 inches.
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For the sake of argument, let's say that we want to print an
8x10". When we changed the Resolution to 240 pixels/inch, the
document ended up larger than we need. So, if we click the
Resample Image checkbox, we can alter the Pixel Dimensions
by changing the Width and Height fields in the Document
Size section of the dialog. Now, change the Height to 8 inches
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and see what happens: the Width changes to 12.045 inches,
the Resolution stays at 240, the Pixel Dimensions change to
2891x1920 pixels and the file size drops to 15.9 MB. Before
doing anything else, I'd use Save As to create an 8x12" version,
while preserving the original, larger photo.

Now, to print an 8x10", you'd have to determine which 2.046
inches to exclude using the Crop tool (C). In the Options Bar,
enter 10 inches for Width, 8 inches for Height, click-and-drag
the cursor across the image to crop to the portion of the image
that you want to keep, and press Return (PC: Enter) to crop the
image to an 8x10".

Using the Resample menu
When you resample a document, either making it smaller
(hopefully) or larger (as infrequently as possible), the Resample
drop-down menu can help you get a better-quality end result.
Depending on how you're resizing the image and the type of
image with which you're working, there are several choices in
the menu: Nearest Neighbor (Preserve Hard Edges), Bilinear,
Bicubic (Best for Smooth Gradients), Bicubic Smoother (Best for
Enlargement), and Bicubic Sharper (Best for Reduction).

Note: The two latest versions of Photoshop have included
a brief description of what the commonly used methods are
best used for: Bicubic Sharper, for example, includes "best for
reduction" next to its name in the Resample menu. Choose
from this menu depending on whether you're "downsam-
pling" (scaling down) or "upsampling" (scaling up).
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Original
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What about making a document
physically larger? Is it possible? Yes.
Advisable? No. Using Image Size to
make a document larger means that
pixels have to be artificially added into
the Pixel Dimensions and, as you can
imagine, the more "fake" pixels that
are added, the more details are lost. So
while it's technically possible to enter a
larger value, the results won't be very
good when you make a document
larger. Some people would argue that
if you're only enlarging 10-20%, the
results are "not too bad." What I'd say
is "Enlarging 10-20% means you won't
notice the fake pixels quite as much as
if you enlarged it 25% or more."

Adjust Pixel Dimensions or

Document Size?

Like many things in Photoshop, for the
question, "Which one should I use: Pixel
Dimensions or Document Size?" the
answer is, "It depends." For example:

• If you're scaling down an image for the
Web or to email to someone, use Pixel
Dimensions to quickly change to a
smaller size and then use File>Save As
to save a copy.

• If you're preparing an image for print-
ing and you need a specific resolution,
then Document Size is the way to go.

And don't be afraid to experiment
inside the Image Size dialog—you can
always click Cancel. Or try this: press-
and-hold Option (PC: Alt) and the Cancel
button will change to Reset so that you
can change the numbers back to square
one and try something else.

Just remember that whenever pos-
sible, you should start with a large
document and make it smaller, rather
than the other way around. So capture
images with your camera at the largest
size possible or create new documents
at the largest size you think you'll need.
You'll always get better quality by
scaling a document down rather than
scaling larger. •
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If you have an idea for a "Beginners' Workshop" topic, please send it to letters@photoshopuser.com; however, if you have a question
that you'd like answered immediately, go to the Help Desk at www.photoshopuser.com.
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